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How to Use this Guide 
 

The Center for Digital Innovation in Learning at Boston College designed a customizable 
Canvas template to help you get started in the development of your online courses. Once 
the template is copied into your Canvas site, you can use this guide to make edits according 
to your needs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Home Page  
 

The Home Page is the first page students see when they enter your online course. We 
designed different home page styles to meet your needs. To view the home page options, 
please go to “Modules” on the left menu in your Canvas course. Scroll down until you find 
the module titled “Home Page Options.” Click on each one of the pages under the title to 
explore your options.  

The “Home” page is the most basic option. Editable fields include:   

●​ Program/Dept Name 
●​ Course Name 
●​ Course ID # | Instructor Name  
●​ Welcome message 
●​ Instructor Information 
●​ Instructor’s headshot   

The rest of the options add to “Home” by displaying the list of modules in the course, 
allowing you to edit the course banner, and providing a page with neutral colors instead of 
BC colors.  

 

 

 

 

 

 

 

 

 

 

 

 

 



1.​ Editing Text 

A.​ Go to “Modules” on the left menu in your Canvas course, scroll down to “Home 
Page Options,” and select the home page you would like to use for your online 
course. 

B.​ Click the “Edit” button on the top right. 

 

C.​ Select the text you would like to edit and replace it with the new information.  

D.​ Click “Save.”  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.​ Editing Banner Image  

Some homepage templates allow you to customize the course banner. You can select an image that 
describes your particular subject area, makes your course unique, and gets students excited to take 
this class.  

Instructions:  

A.​ Go to “Modules” on the left menu in your Canvas course, scroll down to  “Home 
Page Options,” and select the home page you would like to use for your course.  
From the given options, you can choose: 

●​ Home - with Editable Image 
●​ Home - Editable Image, Neutral Color  
●​ Home - Editable Image with Module List 
●​ Home - Editable Image with Module List, Neutral Color  

B.​ Select the “Edit” button on the top right. 

 

C.​ Double click on the banner image until you see it highlighted in blue.  



 

D.​ Select the “Embed Image” icon on the text editor.  

 

E.​ Choose the “Canvas” tab. 

F.​ Select “Course Files.” 

G.​ Click on “Upload File” to upload the image you would like to use as the new banner. 
Images will fit best if they are around 800-900 pixels wide and less than 200 - 400 pixels 
height.  

H.​ Either add Alt text to describe the image for accessibility or check “Decorative 
Image.” 

I.​ Click “Update.”  



 

 

 

 

 

 

 

 

 



3.​ Adding Instructor Headshot  

A.​ Go to “Modules” on the left menu in your Canvas course, scroll down to “Home 
Page Options,” and select the home page you would like to use for your online 
course.  

B.​ Select the “Edit” button on the top right. 

 

C.​ Click on the Boston College logo. When selected, you will see the image highlighted 
in blue.  

 

D.​ Click on the “Insert / Edit Image” icon in the text editor.  

 

E.​ Choose the “Canvas” tab. 

F.​ Select “Course Files.” 

G.​ Click on “Upload File” to upload the image you would like to use as your headshot 
from your computer.  

H.​ Click “Update.”  

 



 

I.​ Drag the corners of the image to resize it to your preferred size.

 

J.​ Click “Save.”  



 

4.​ Editing Module List ​  

Some homepage templates have an optional module list that provides an overview of the 
course structure. You can customize this by adding the module names and adding links to 
each module. 

 

Instructions 

A.​ Go to “Modules” on the left menu in your Canvas course, scroll down to “Home 
Page Options,” and select the home page you would like to use for your course.  
From the given options, you can choose:  

●​ Home - with Module List 
●​ Home - Editable Image with Module List 
●​ Home - Editable with Module List, Neutral Color  

B.​ Select the “Edit” button on the top right. 



 

C.​ Scroll down to the module list 

D.​ For each module, delete the text in the title column. Navigate to the Content 
Selector on the right. Click on “Modules” located under the “Links” tab, and 
select the module you would like to link.  

 

E.​ Click the “Save” button at the bottom of the page.  

 

 

 

 

 

 

 

 

 

 

 



5.​ How to Choose a Home Page 

To make the new Home Page the landing page in your Canvas course, please follow these 
steps:  

A.​ Go to “Pages” on the left menu in your Canvas course.  

B.​ Look for the page you would like to set as the home page and click the “Publish” 
icon. The icon will turn green, which indicates that the page is visible to participants 
in the class (if the course was already published.) 

C.​ Click on the Options icon (three dots next to the page) and select “Use as Front 
Page.”  

 

D.​ Go to the “Home” tab on the left navigation menu.  

E.​ From the buttons on the right side of the screen, select “Choose Home Page.”  

 

F.​ Click on “Pages Front Page.”  

G.​ Click “Save.”  



 

 



How to Use the Course Orientation 
 

Think about the course orientation as a start-up unit that contains all the information students need 
to get started with the course. It is similar to the first hour of your first day of class, where you go 
over the syllabus, talk about the highlights of the class, the grading structure, and address some of 
the policies you would like students to abide by, such as “no late assignments” or “academic 
integrity.”  
  
The “Course Welcome” page and the “Course Expectations and Schedule” page are for you to 
fill out in its entirety.  
  
The “Institutional Policies” page has a summary of BC policies, but you may want to include your 
course policies as well. On the same page, under the “Participation” header, we have included a 
placeholder for you to add your course participation policy. Under “Accessibility,” you will find the 
accessibility policies of the tools that are used frequently in BC online courses. If you are using 
additional tools, we recommend that you add the accessibility policies here.  

 

 

The “Introduction to Online Learning” page does not need any edits, and the “Technologies 
and Support” page only needs editing if you are using additional tools that were not listed here.  
  
The “General Course Questions” discussion is a space where students can add any questions 
about the course. Feel free to edit the description text to make it your own. The “Meet Your 
Classmates” discussion allows students to get to know each other and their instructor. We 
recommend you ask students specific questions to help them engage. You can also model the 
introduction by posting your own.  



Modules  
1.​ What Are Modules?  

Learning modules are a way of packaging course materials in a logical, sequential order. We 
use modules to guide students through the content and assessments that will help them meet 
the course goals and objectives.  

Learning modules are usually organized by weeks or by topics. Each module will include all the 
course materials, learning activities, and assessments students need to complete before they 
move to the next week or topic.  

We know that not every course follows a linear format.  If you are struggling to make this 
course structure work then you should consult your CDIL assigned learning designer. If you are 
working outside of a CDIL program then contact cdil-inbox@bc.edu but please be advised 
support for courses being developed outside of the CDIL process is minimal.  
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2.​ How to Edit a Module Title 

To edit a module title, please follow these steps:  

A.​ Go to “Modules” on the left menu in your Canvas course. 

B.​ Scroll down to the module you would like to edit and click on the Options icon (three 
dots next to the title of your module.) 

C.​ Select “Edit.”  

 

D.​ Click on the text box to edit the title of your module.  

E.​ Click “Update Module.”  

 



3.​ Adding Content to a Module  

A.​ In Course Navigation, click the Modules link. 

B.​ Click the Add (+) icon on the module title.  

 

C.​ Click the Add drop-down menu and select one of the following item types: 

●​ Assignment (includes quizzes created using the New Quiz tool) 
●​ Quiz 
●​ File (document and media file types) 
●​ Page 
●​ Discussion 

Note: Canvas will accept most media files as uploads. However, not all media files 
can be played within Canvas. 

 

D.​ Once you select one of these items, you will be able to create a new item from 
scratch or choose from existing ones. Depending on the item type, when adding new 
content, you may be asked to complete additional fields. 

E.​ Choose the Indentation drop-down menu to indent the item inside of the module. 

 

https://community.canvaslms.com/t5/Instructor-Guide/What-types-of-files-can-be-previewed-in-Canvas/ta-p/607
https://community.canvaslms.com/t5/Instructor-Guide/What-types-of-media-files-can-I-upload-in-Canvas-as-an/ta-p/1142


F.​ Select “Add Item.”  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4.​ Remove Content within a Module  

A.​ In Course Navigation, click the Modules link. 

B.​ Click the Options icon. 

C.​ Select the Remove link. 

 

D.​ Click the OK button. 

 

 

 

 

 

 

 

 

 

 

 

 



5.​ Duplicating Content  

A.​ Locate the module item you want to duplicate. 

B.​ Click the Options icon.  

C.​ Click the Duplicate link.  

 

Note: If a module item cannot be duplicated, the Duplicate link will not display in the options 
menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6.​ Locking a Module 

A.​ Go to “Modules” on the left menu in your Canvas course. 
B.​ Scroll down to the module you would like to lock and click on the Options icon. 
C.​ Select “Edit.”  

 
D.​ Click the “Lock until” checkbox. 
E.​ In the “Unlock” field, enter a date that the module should unlock. 
F.​ You can also use the calendar to select a date. Click the Calendar icon. In the 

calendar, click the date the module should unlock. If you want to set a specific time, 
enter a time in the time field. Click the Done button. 

G.​ Click the “Update Module” button. 

 
H.​ The unlock date and time will appear next to the bottom of the module. 



7.​ Publishing a Module  

A.​ Go to “Modules” on the left menu in your Canvas course. 

B.​ On the Index page, you can view the state of each module. Gray icons indicate 
unpublished modules. You can change the status of a module by toggling the 
published or unpublished icons. 

 

C.​ To publish a module, click the module's unpublished icon. The hover text will confirm 
you want to publish the module. The green icon indicates that the module is 
published. 

●​ Note: Publishing a module will automatically publish any unpublished content 
items within the module. 

D.​ To unpublish a module, hover over the published icon. The hover text will confirm 
you want to unpublish the module. Click the icon to confirm. Gray icons indicate the 
module is unpublished. 

 



How to Edit 
1.​ Pages 

A.​ Go to “Modules” on the left menu in your Canvas course. 

B.​ Click the title of the page you would like to edit.  

Note: You can identify a page by the paper icon next to the title.  

 

C.​ Click the Edit button on the top right of the screen. 

 

D.​ Add text and other types of content such as links, images, files using the Content 
Selector. 

E.​ Edit the content and add links and media using the Rich Content Editor, where you 
can find commonly used tools such as “Link to URL” to create hyperlinks and 
“Embed Image” to add an image to the page.  

F.​ Click the Save button. 

 



 

2.​ View and restore page history  

A.​ Go to “Modules” on the left menu in your Canvas course. 

B.​ Click the title of the page you would like to edit.  

C.​ Click the Options icon  

D.​ Select the View Page History link. 

 

E.​ By default, the page history will show the latest revision. 

 

F.​ To open a prior version of your page, click the date you want to access and 
then click the Restore this revision link. 

Note: Students cannot restore a prior version of a page within a course. 

 



 

G.​ Canvas will restore the prior version to the most recent revision. If you want to 
replace your current page with different content, click a different date and 
page revision. Note that restoring a page revision will also associate your 
name with the page history. 

H.​ To return to the current page revision, click the close icon.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



3.​ Discussions 

A.​ Go to “Modules” on the left menu in your Canvas course. 

B.​ Click the title of the discussion you would like to edit. 

C.​ Click the Edit button on the top right of the screen. 

 

D.​ Add content to your page using the Content Selector.  

E.​ Edit the content and add links and media using the Rich Content Editor, where you 
can find commonly used tools such as “Link to URL” to create hyperlinks and 
“Embed Image” to add an image to the page.  

F.​ You can also add an attachment to your discussion by clicking the Choose File 
button. 

 

Under the “Options” headers, you will be able to:  

G.​ Create a threaded discussion. By default, discussions are created as focused 
discussions. 

H.​ Require users to reply to the discussion before they can see any other replies. 

I.​ Enable a discussion podcast feed. 

https://community.canvaslms.com/t5/Instructor-Guide/How-can-I-require-students-to-reply-to-a-course-discussion/ta-p/1100
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-enable-a-podcast-feed-for-a-discussion-in-a-course/ta-p/1096


J.​ Make this a graded discussion. This option will change the rest of the discussion 
settings.   

Note: In this guide, we’ll focus on graded discussions. If you want to know more 
about non-graded discussions, please go to the “How do I create a discussion as 
an instructor?” tutorial.  

K.​ Allow students to like discussion replies. 

L.​ Make the discussion a group discussion

 

M.​ Enter the number of points possible. Select the Grading Type and Assignment 
Group, and assign Peer Reviews, if any. 

 

N.​ Assign your graded discussion for everyone in your course, or to specific course 
sessions.  

O.​ Add your preferred date(s) with the following options: 

https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-discussion-as-an-instructor/ta-p/1029
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-discussion-as-an-instructor/ta-p/1029
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-allow-students-to-like-replies-in-a-discussion/ta-p/1027
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-group-discussion-in-a-course/ta-p/911


i.​ Due: Set the date and time that the graded discussion is due. The due date 
will already be populated for you if you created a discussion shell, but you 
can change it if necessary. 

ii.​ Available From: Set the date and time when the discussion will become 
available. 

iii.​ Until: Set the date and time when the discussion will no longer be available. 

 

P.​ If you are ready to publish your discussion, click the Save & Publish button. If you 
want to create a draft of your discussion and publish it later, click the Save button. 

 

 

 

 

 

 

 

 

 



4.​ Assignments  

A.​ Go to “Modules” on the left menu in your Canvas course, and click the title of the 
assignment you would like to edit.  

B.​ Use the Content Selector in the Sidebar to link to or upload course resources, 
including files and images. 

C.​ Use the Rich Content Editor to add images, text, links, equations, or insert media. 

 

D.​ Enter the points for your assignment in the Points field. 

Note: Points possible must be set to a number greater than zero for assignments 
with percentage, points, letter grade, or GPA grading types. 

E.​ Select or create the assignment group (these are categories that mirror your grading 
criteria and will help you keep your gradebook organized).  

F.​ In the Display Grade as drop-down menu, select the method you want to use for 
grading. You can grade your assignment by percentage, complete/incomplete, 
points, letter grade, GPA scale, or set as not graded. 

Note: The grading type is how the assignment score will display in the Gradebook. 
For example, an assignment worth 10 points is set to display as a percentage. A 
student who receives 8/10 points on the assignment will show as 80 in the 
Gradebook. If using a letter grade, learn how to create a grading scheme, and 
apply a grading scheme to your assignment. 

https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-add-a-grading-scheme-in-a-course/ta-p/1054
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-add-a-grading-scheme-to-an-assignment/ta-p/1066


 

G.​ In the Submission Type drop-down menu, select the type of submission you want to 
accept for the assignment. By default, the submission type will be set to “Online.” 

i.​ No Submission is when you do not want students to submit an assignment in 
Canvas. This assignment type can be used to create extra columns in the 
Gradebook, or when you want to create an assignment that involves multiple 
scores. Submission Type does not apply to Not Graded assignments. 

ii.​ Online is when you want students to submit their assignments using Canvas. 

Note: If you select the Online submission type, you can limit submission 
attempts for the assignment. 

iii.​ On Paper is when you want students to submit an assignment to you but not 
through Canvas. This assignment type applies to traditional face-to-face 
courses or hybrid courses when you want the assignment turned in during 
class, but you still want to create a column in the Canvas Gradebook for 
grading purposes. 

iv.​ External Tool is when you want students to submit their assignments using an 
external app (LTI) enabled for your course. You must enter a URL for the 
external tool. 

H.​ You can also set up an assignment as a group assignment. You can also choose to 
grade students individually in group assignments. 

I.​ If you want to require students to review each other's work, you can create a peer 
review assignment. When requiring peer reviews, you can select whether to 
manually assign peer reviews or automatically assign peer reviews. 

https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-an-online-assignment/ta-p/950
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-limit-submission-attempts-for-an-assignment/ta-p/878
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-limit-submission-attempts-for-an-assignment/ta-p/878
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-add-an-assignment-using-an-external-app/ta-p/656
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-assign-an-assignment-to-a-course-group/ta-p/633
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-peer-review-assignment/ta-p/641
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-peer-review-assignment/ta-p/641


 

J.​ If you want to set up an assignment with additional reviews, you may be able to 
enable Moderated Grading, Anonymous Grading, or both. Moderated grading 
allows multiple graders to evaluate a student's work and create provisional grades. 
Anonymous grading hides student names from graders when they view 
assignment submissions in SpeedGrader. These options can be used together or 
independently. 

K.​ If you want to assess submissions with DocViewer and make all instructor 
annotations and comments in DocViewer-supported submissions anonymous, select 
the Anonymous Instructor Annotations checkbox. 

L.​ By default, Canvas will set your assignment dates for everyone in your course. 
However, you can assign the assignment to an individual student or course 
section. 

M.​ Create a due date for the assignment in the Due Date field. You also have the option 
to add availability date fields. 

https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-add-a-moderated-assignment-to-be-graded-by-multiple/ta-p/605
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-add-an-assignment-that-includes-anonymous-grading/ta-p/769
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-enable-anonymous-instructor-annotations-in-student/ta-p/665
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-assign-an-assignment-to-an-individual-student/ta-p/717
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-assign-an-assignment-to-a-course-section/ta-p/914
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-assign-an-assignment-to-a-course-section/ta-p/914
https://community.canvaslms.com/t5/Instructor-Guide/What-is-the-difference-between-assignment-due-dates-and/ta-p/897


 

N.​ If your assignment has not yet been published, the assignment will show the Save & 
Publish button. The Save button will create a draft of your assignment so you can 
publish it later. 

 

 

 

 

 

 

 

 



Quizzes 
1.​ Create a new Quiz 

A.​ In Course Navigation, click the Quizzes link. 

 

B.​ Click the Add Quiz button. 

 

C.​ In the Details tab, enter the name of your quiz. In the Rich Content Editor, introduce 
your quiz with formatted text, images, video, or sample math equations. You can 
even use the media commenting tool to record an introduction to the quiz. 

 



D.​ Complete the rest of the quiz details. 

E.​ Click the Questions tab.  

F.​ Manually create a new quiz question by clicking the New Question button. 

 

G.​ Quiz questions are not automatically numbered for instructors. To add a custom 
name to your quiz question, enter the name in the question text field. Custom names 
can help you identify quiz questions more easily. Regardless of the question name, 
students always see quiz questions in numerical order (i.e. Question 1, Question 2). 

H.​ In the question type drop-down menu, you can create the following types of quiz 
questions: 

●​ Multiple Choice 
●​ True/False 
●​ Fill-in-the-Blank 
●​ Fill-in-Multiple-Blanks 
●​ Multiple Answers 
●​ Multiple Drop-down (can be used for Likert scale) 
●​ Matching 
●​ Numerical Answer 
●​ Formula (simple formula and single variable) 
●​ Essay 
●​ File Upload 

I.​ You can link course content to create Quiz questions, such as linking a diagram 
image. You will use the Rich Content Editor to link to content in your quiz question.  

J.​ If you want to add course content to your quiz question, you can access it in the 
content list on the sidebar. You can upload images and files from your desktop or link 
to images and files you have previously uploaded. 

https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Multiple-Choice-quiz-question/ta-p/682
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-True-False-quiz-question/ta-p/927
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Fill-in-the-Blank-quiz-question/ta-p/889
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Fill-in-Multiple-Blanks-quiz-question/ta-p/923
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Multiple-Answers-quiz-question/ta-p/924
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Multiple-Dropdown-quiz-question/ta-p/916
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-Likert-scale-quiz-questions/ta-p/942
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Matching-quiz-question/ta-p/918
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Numerical-Answer-quiz-question/ta-p/919
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Simple-Formula-quiz-question/ta-p/1233
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-Formula-quiz-question-with-a-single-variable/ta-p/920
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-an-Essay-quiz-question/ta-p/909
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-create-a-File-Upload-quiz-question/ta-p/652
https://community.canvaslms.com/t5/Instructor-Guide/How-do-I-link-course-content-to-a-quiz-question/ta-p/1155


K.​ To set the point value for the question, enter the points in the pts field. Note: Quiz 
point values support up to two decimal places. Entering more than two decimal 
places will round the point value to the nearest hundredth. 

 

 

L.​ To save your question, click the Update Question button. 

 

M.​ Click the Save button to save your work and preview the quiz. Note: You should not 
publish your quiz until it is your final product. If you are ready to publish your quiz 
and make it available to students, click the Save & Publish button. 

 

N.​ Click the Preview button to see what students will see when they take the quiz. If the 
preview shows the quiz the way you want it, click the Publish button. Note: Although 
you can make changes to the quiz after it is published, students who have already 
opened or completed the quiz will not see any of the changes, which may affect their 
grades. 

 



Adding Files, Links, and Images 
The Rich Content Editor and the Content Selector are Canvas tools that appear on every item 
(pages, discussion, assignments, quizzes). In this section, you will learn how to use both of these 
tools to add files, links, images, and videos to your course.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



1.​ Adding Files  

A.​ Select the content area where you would like to add the file (page, discussion, assignment, 
quiz.) 

B.​ Click “Edit” on the top right. 

 

C.​ Inside the text box, click on the area where you want your file to appear. 

D.​ Locate the Content Selector on the right side of the screen and click the “Files” tab.  

E.​ From here, you have two options:  

●​ If the file has been uploaded to Canvas, click on the name of the file, and it will 
immediately appear in the text editor.  

 

●​ If the file has not been uploaded to Canvas, click on “Upload a New File” → Choose 
File. Locate and upload the file from your computer, then click “Upload.”  



 

F.​ Click “Save” at the bottom of the page.   

 

 

 

 

 

 

 

 

 

 

 

 



2.​ Adding External Links 

A.​ Select the content area (page, discussion, assignment, quiz) where you would like to add 
the file. 

B.​ Click “Edit” on the top right. 

 

C.​ Go to the website you would like to link and copy the URL.  

D.​ Go back to Canvas, and inside the text box, highlight the text you would like to link.  

E.​ Select the “Link to URL” button in the Rich Content Editor and paste the URL. 

F.​ Click “Insert Link.”  

G.​ Click “Save” at the bottom of the page.  

 

 



3.​ Adding Links to Canvas Content Areas  

A.​ Select the content area (page, discussion, assignment, quiz) where you would like to add 
the link.  

B.​ Click “Edit” on the top right. 

 

C.​ Inside the text box, click on the area where you want the link to appear. 

D.​ Locate the Content Selector on the right side of the screen. 

E.​ Select what type of content you want to link, for example, a link to an assignment, a page, 
etc.  

 

F.​ Click “Save” at the bottom of the page. 

 

 

 

 



4.​ Adding Images  

A.​ Select the content area (page, discussion, assignment, quiz) where you would like to add 
the image. 

B.​ Click “Edit” on the top right. 

 

C.​ Inside the text box, click on the area where you want your image to appear. 

D.​ Locate the Content Selector on the right side of the screen and click the “Images” tab.  

E.​ From here, you have two options:  

●​ If the image has been uploaded to Canvas, click on the name of the image, and it will 
immediately appear in the text editor.  

 

●​ If the file has not been uploaded to Canvas, click on “Upload A new image” → Choose 
File. Locate and upload the file from your computer. You will be asked to provide an Alt 
Text or description of the image. If your image is only for decoration purposes and does 
not add to student’s learning, click on the “Decorative image” checkbox. Click 
“Upload” to insert the image.  

 



 

F.​ Click “Save” at the bottom of the page   

 

 

 



Panopto  
1.​ Create a Panopto recording and publish to Canvas 

2.​ Embed Panopto Video on Canvas  

Recent major Panopto upgrade means that access permissions to Panopto videos is most 
reliably provided by Canvas not from Panopto Admin. Viewers must be students enrolled in 
the course. To embed videos the embedder must be enrolled in the course as a teacher 
or designer.  

Permissions are tied to the video not the folder. So videos can be reused but they must be 
embedded by someone with a teacher/designer role in the relevant course using only the 
wysiwyg approach to embedding videos (outlined below). 

The wysiwyg approach to embedding videos (outlined below) must always be used, never 
the ‘Panopto Recordings’ link on the left hand Canvas course navigation bar as it will create 
different viewing permissions.  

Instructions:  

A.​ Go to “Modules” on the left menu in your Canvas course, and click the title of the 
content area (page, discussion, assignment, quiz) where you would like to add the 
video.  

B.​ Select “edit” at the top of the page. 

 

C.​ Click on the area where you want your video to be located.  

D.​ In the text editor tools, select the “external tools” icon. 

E.​ From the external tools menu, select  “Panopto Recordings”  

F.​ Click on the video you would like to add, then click “Insert.”  

G.​ Click “Save” at the bottom of the page  

​ Note: For visuals on steps C-G, please see the animated image below  

 

 

http://cteresources.bc.edu/documentation/panopto/create-a-panopto-recording-publish-to-canvas/


 

3.​ Additional Panopto tutorials  

 

https://cteresources.bc.edu/documentation/panopto/
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